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TECHNICAL APPLICATION GUIDE

FDM FOR END-USE PARTS

End-use parts include all components, sub-assemblies and products created 
during both series production and/or custom manufacturing.

Additive manufacturing is a viable alternative to molding, machining, forming 
and casting of end-use parts. These traditional processes rely on tools and dies 
when production volumes are moderate or high. For low quantities, conventional 
approaches often rely on manual or semi-automated machining, forming and 
fabrication. 

Fused Deposition Modeling™ (FDM®) is an additive manufacturing technology 
that eliminates tools and dies in order to streamline the production process.  
Substituting FDM for traditional manufacturing processes substantially reduces 
lead times and costs. It also makes production a simple, unattended and virtually 
labor-free operation. 

For those willing to break free of the status quo, FDM also creates new design 
opportunities. Parts can be designed for optimal performance and ergonomics 
since additive manufacturing places few constraints on design configurations. 
There is no investment in tooling so part configurations can change with each 
production run.

Production lot of Nova Tech Engineering’s end-use parts.
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1. Overview

1.1.	 Application:

FDM is an alternative manufacturing method for end-use parts including 
finished goods and sub-assemblies. It may be substituted for processes 
that use molding, machining, casting and forming.

1.2.	FDM is a best fit when:

•	Time and cost for tooling (or machining) are obstacles.

-- Low, up-front investment and fast turn-time needed to enhance 
profitability or meet product launch schedules

•	On-demand, just-in-time (JIT) manufacturing is used.

-- For small-batch manufacturing 
-- For smaller inventories
-- For flexible production schedules

•	Design modifications are expected.

-- Custom and configured-to-order products.
-- Products that will be revised throughout the life cycle.

•	Optimized designs are needed.

-- Design for function and performance rather than process.
-- Little or no penalty for complex, feature-rich parts.

•	Low-volume production is utilized.

-- Generally, practical production quantities are between 1 - 1,000+
-- Quantity is dependent on part size; smaller parts can have larger 
production quantities.

•	Optimal part size

-- Smaller than 300 mm (12 in) for XYZ.
-- Larger parts are possible.

•	Materials are compatible.

-- Confirm suitability of thermoplastic materials to ensure:
-- Mechanical and electrical properties
-- Chemical resistance and thermal resistance

•	FDM accuracy is suitable.

-- Without secondary machining, > 0.13 mm (0.005 in).
-- With secondary machining, tighter tolerances are possible.

1.3. Successful adopter traits (first iteration and long-term):

•	Customer is open to change and seeking innovation.

-- Part design
-- Manufacturing processes
-- Business models

•	Start simple, then advance.

-- Tackle straightforward applications first.
-- With experience, move on to more demanding parts.

•	Design for performance, time and cost.

-- Start with a fresh design that optimizes part qualities as well as 
FDM build time and material consumption.

Figure 1: Processing equipment component (PC-ABS).

Figure 2: Electronic surveillance equipment includes FDM 
housing (ABS-M30).

Figure 3: MRI head coil required compatible materials 
(PC-ISO).
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•	Understanding when FDM is the best alternative.

-- Continue to use traditional methods in combination with FDM.
1.4. FDM Adoption Obstacles:

1.5. Benefits:

•	Lead time reduction

-- Average lead time savings: 75% to 90%
-- Shift from prototyping to production in one day.

•	Cost reduction

-- Average cost savings:  50% to 90%
-- No up-front cost; eliminate expense of tool design and tool 
making.

•	Digital inventory

-- Utilize just-in-time manufacturing.
•	Design freedom

-- Improve product performance.
-- Maximize ergonomics.
-- Consolidate multi-piece assemblies.

•	Design flexibility

-- Modify product designs at any time.
•	Streamlined operations

-- Few steps and few resources needed for production runs.
•	 Profitable production of low-volume, high-complexity parts.

Obstacle Solution*

Adhering to traditional design practices. •	 Optimize part design for FDM as outlined in FDM Design Handbook.

•	 Create application specific “best practices” when not defined in FDM Design Handbook.

Applying FDM to high-precision applications. •	 Offset surfaces in CAD.

•	 Orient critical dimensions in the XY plane.

•	 Use secondary machining operations.

Considering FDM as a complete replacement 
for existing processes.

•	 Use FDM as an alternative when other processes cannot deliver.

•	 Combine FDM and traditionally manufactured parts.

Focusing only on piece-part cost. •	 Include cost reductions from all operations (e.g. design to warehouse and transportation).

•	 Include, where applicable, financial gains from optimized designs when put into service.

FDM part requires extensive post-processing. •	 Leverage automated processes such as mass finishing.

Making large, bulky parts without modification. •	 Reduce time and material with sparse fills and large rasters.

•	 Reduce time by making supports from model material.

•	 Use evenings and weekends for long builds.

Using green flag (default) process parameters. •	 Use Insight software to adjust strength, porosity, surface quality and weight.

* Additional solutions may exist.

Figure 4: Bezel for pharmacy equipment (ABS-M30).
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2. Roles & Strategies
This guide presents tips and techniques that leverage the advantages of FDM 
while optimizing part quality and operational efficiency. The degree to which 
these are applied is dependent on the role that the end-use parts will play. 
If used as an interim or stopgap solution, only minor adjustments may be 
warranted. Consequently, if FDM will be the long-term production process, any 
time invested in design and preparation will be justified by the gains in quality 
and productivity. 

2.1.	Pilot production (Figure 6)

FDM is the short-term solution for end-use part production. After the 
pilot is complete, parts are produced through a traditional manufacturing 
process. In this capacity, design modifications are undesirable and gains 
from process refinement are short-lived.

For pilot production, use the part design that suits the conventional 
production method. The “freedom of design” that FDM offers means that 
changes may be unnecessary.

•	Leave part design unchanged.

•	Make minor process adjustments.

2.2.	Bridge-to-production

In this role, FDM is an interim solution used to bridge the time span 
between product launch and production line start-up. For example, FDM 
could be used to produce parts while awaiting delivery of an injection 
mold.

Since production will be handed off to a traditional manufacturing 
process, design alterations are not desirable. However, if the time span 
and production quantity are significant, minor design alterations may be 
incorporated. The production quantity is also likely to warrant a larger up-
front investment of time.

•	Consider minor design changes.

•	Tune process to optimize performance.

2.3.	Full production (Figure 7)

When FDM will be the only method of end-use part production, optimize 
every aspect of the part and its production. This will maximize product 
performance and throughput while minimizing cost. 

Optimization includes designing the part purely for its function; ignore 
established design for manufacturability rules.

•	Complete redesign is justifiable.

•	Fine-tune process for maximum optimization.

•	Continue to redesign throughout the product life cycle.

Figure 6: Pilot production: minor process adjustments are 
acceptable. (PC-ABS)

Figure 5: Gauge pod for custom motorcycle (painted 
polycarbonate).

Figure 7: Full production: optimized orientation and pack for 
throughput (polycarbonate).
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2.4. Bridge-to-end of life

As a product nears the end of its life cycle, further investments in repairing 
or replacing tooling may not be justifiable. As a result, production may be 
halted prematurely while spare parts are still needed.

FDM may be used to extend a product’s life and to manufacture spare 
parts on an as-ordered basis, thereby eliminating the need for physical 
inventory. As with full production, optimize both the part design and the 
FDM process while maintaining fit, finish and performance standards.

•	Complete redesign is justifiable.

•	Fine-tune process for maximum optimization.

3. Design for Function (CAD)
A common way to apply FDM Technology™ to end-use parts manufacturing is 
to use existing designs and design rules. However, they may not capitalize on 
the advantages of FDM. In fact, they may negatively affect performance, time 
and cost. 

Whenever possible, start with a fresh design that builds on the design freedoms 
offered by FDM and optimizes part production. 

3.1.	 Integrated design (consolidation) (*) (De)

Convert assemblies into single parts. Components are often dissected 
into many pieces in order to make conventional manufacturing processes 
feasible and affordable (Figures 8 and 9). This is unnecessary with FDM.

If reproducing an existing part, integrate as many components as possible 
into one piece (Figure 10). If designing a new item, create it as one piece. 
Only split off parts when it is advantageous to the part’s operation or 
maintenance.

Integrated design has many advantages including:

•	Improved functionality

-- Focus on the task that the part will perform. Optimize its design 
for function rather than the process used to make it.

•	Eliminate tolerance challenges.

-- Holding tight tolerances is costly. If two mating parts are 
combined into one, concerns related to controlling the tolerances 
are eliminated.

•	Eliminate assembly time.

-- Assemblies, obviously, must be assembled and this takes time. 
Consolidate all parts into a single piece to eliminate the time 
needed for assembly.

•	Decrease bill of materials (BOM) count.

-- Smaller part counts decrease the time and expense for managing 
and warehousing inventory.

3.2.	Integrated features (*) (De)

There are two aspects to integrated features: adding features and inserting 
hardware.

Figure 8: Part split into pieces to aid in assembly of final product 
(polycarbonate).

Figure 9: Final product next to FDM component. Material 
properties allow for MRI functionality (polycarbonate).

Figure 10: Redesigned FDM tool consolidates most 
components (ABS-M30).
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3.2.1.	Adding features

With traditional manufacturing processes, there is usually a 
cost associated with every feature. This is not true with additive 
manufacturing, especially when material is removed. 

In the design of an FDM part, consider adding features that improve 
performance, reduce build times and reduce material costs. 
For example:

•	 Add pockets, channels and holes (Figure 13).

-- Removing mass from the part will decrease weight, 
material consumption and build time.

•	 Add ribs, bosses and gussets.

-- This may increase build time and material cost, however 
the impact is far less than that of a traditional process.

•	 Add embellishments (Figure 14).

-- Incorporate part numbers, storage locations, alignment 
aids, logo or operational instructions directly on the part.

3.2.2.	Adding hardware (Figures 15 - 17)

As with traditional manufacturing, hardware may be added in a 
secondary operation. For example, threaded inserts can be press-fit 
into location holes added to the CAD model or machined after the 
FDM part has been built.

An alternative is to mimic insert molding. In the CAD model, add 
a pocket or hole that will contain a sensor, RFID tag, bushing or 
threaded insert. During the FDM build process, pause the job, place 
the item in the part, and resume the build. The hardware is now 
integrated with the FDM part.

3.3.	Maximize fill density (**) (St)

FDM parts use an internal raster fill bounded by external contours. For thin 
features (i.e. less than 1.52 mm / 0.060 in), there may not be enough space 
for the internal rasters (Figure 18). This may result in an internal void. These 
voids can be eliminated in Insight software (see Section 5.3.) or prevented 
in CAD.

In the CAD model, avoid tapers or draft angles for thin-walled features. 
Since FDM uses a continuous, fixed-width extrusion for each curve, the 
gradual change in width will yield a void. 

3.3.1.	CAD revision (Figure 19)

To prevent these gaps, make the feature thickness constant in the XY 
plane. The thickness may vary at different Z elevations but it is best 
to include discrete, stepped changes rather than gradual changes 
(e.g., from a draft angle).

3.3.2.	Optional revision

Create each feature such that its wall thickness is an even multiple 
of the contour width (see Section 5.4.2. for details) used to make the Figure 15: Fasteners may be mounted to  

FDM parts (ABS-M30).

Figure 13: Three design options – adding features improves 
performance while decreasing time and expense.

Figure 14: Add embellishments to end-use parts such as part 
numbers (PC-ABS).

Figure 11: Original design – single component.

Figure 12: Consolidated design – integrated mounting flange.
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part. If modeled in this fashion, the feature will not 
require a custom group to have full density.

3.4.	Self-supporting angles (***) (Ti)

Supports are added to the bottom of a part and to 
all features with an angle, as measured from the XY 
plane, that are less than the self-supporting angles 
in the software (Figure 20). Since supports increase 
build times and material expense, it is advantageous to 
minimize them. One way to do this is to modify the CAD 
model.

3.4.1.	Identify features (Figures 21 and 22).

The default self-supporting angle ranges from 40° 
to 45°. Review the model to identify any features 
that are near this angle and can be modified.

3.4.2.	Adjust features.

Alter the design of the identified features by 
increasing the angle such that it is > 45° from the 
XY plane. For features less than 6.3 mm (0.25 in) 
wide in the XY plane, a cylindrical profile may be 
used (Figure 23).

Alternatively, the self-supporting angle may be 
adjusted in the software (Support > Setup > 
Support Parameters). In general, a 3° adjustment 
is safe.

3.5.	Variable density (***) (St, Ti)

A unique characteristic of FDM is that a single part can 
have regions with different build styles. The advantages 
of this characteristic include varying density for:

•	Optimal strength and weight.

•	Optimal time and cost.

To some degree, this can be achieved in the software 
by using custom groups (Figures 24 and 25). For 
advanced control, make changes to the CAD model so 
that each region is processed with different toolpath 
options (Figures 26 and 27).

3.5.1.	Modify CAD model.

3.5.1.1.	Create CAD model of part.

Begin with a complete CAD model of the 
part. Next, place the model in the same 
orientation in which it will be built .

To assist with alignment in the software, 
add a reference feature. Locate this 

Figure 19: CAD revisions produce a constant 
wall thickness that has a solid, dense fill.

Figure 20: Insight software’s self-supporting 
angle specifies when support structure 
is needed.

Figure 21: Review CAD model for features 
that may avoid supports. 

Figure 16: Integrated bushing is embedded 
while part is building (ABSplus).

Figure 17: Threaded insert may be added 
during FDM builds or in secondary 
operations (ABS-M30).

Figure 18: Thin-walled features with taper, 
may have air gaps between contours.

Figure 22: Supports on back of part where 
ribbing is below the self-supporting angle.

Figure 23: With minor alteration to rib design, 
supports are no longer needed.



FDM FOR END-USE PARTS

FDM FOR END-USE PARTS  /  9

feature at the origin (0, 0, 0) and make it 
slightly taller than the part (Figure 28).

Save the model.

3.5.1.2.	Extract first region.

Extract the first variable density region 
from the CAD model and delete the 
balance (Figure 29).

Note: The reference feature must be 
retained. 

Export this file as a high resolution STL.

3.5.1.3.	Extract second region (Figure 30).

Open the original CAD file and extract 
the next region. As with the first, retain 
the reference feature while deleting the 
balance of the model.

Since Insight software will combine curves 
that appear to overlap, adjust this region 
by offsetting all surfaces that coincide 
with the first region. A surface offset of 
0.03 mm (0.001 in) will suffice.

Export the file as a high resolution STL.

Note: Large facets can create regions of 
overlapping curves between parts. This 
can create problems during toolpath 
generation.

To avoid this problem, use small facets 
and visually inspect all layers after 
toolpath generation in the software.

Repeat this step for all other regions of 
the tool.

3.5.2.	Process regions in Insight software.

3.5.2.1.	Process first region.

Open the STL file for the first region 
(Figure 31). Select the model material and 
slice height. Then, orient and slice the 
file. Confirm that the reference feature 
is located at the origin to ensure that all 
regions will be aligned.

Next, apply toolpath settings to achieve 
the desired characteristics for the region. 
For example, change the “Part interior 

Figure 26: CAD model of part.
Figure 27: Transparency shows two regions of 
variable density.

Figure 24: Solid-normal fill throughout 
part.

Figure 25: Sparse – double dense fill in 
narrow section when custom groups are 
used.

Figure 28: CAD model with reference 
feature at 0,0,0.

Figure 29: Cross-section showing region 1 
with region 2 extracted. 
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style” to “Sparse-double dense”. This 
must be done through custom groups 
(Toolpaths > Custom group > Add).

Now, save the job (File > Save as > Job).

3.5.2.2.	Repeat.

For all but the last region, repeat step 
3.5.2.1. All must use the same model 
material, slice height, and orientation. 

3.5.2.3.	Process last region.

Open, orient and slice the last STL file 
and apply the desired toolpaths by using 
custom groups.

Save the job and keep the file open (File 
> Save as > Job). Next, add the previous 
regions (Slice > Combine slice curve files). 
The reference feature will force all regions 
to align to each other (Figure 32).

After all regions have been added, 
select and delete the curves for all of 
the reference features (Edit > Delete > 
Curves).

Save the job and continue with the usual 
file preparation procedures (File > Save as 
> Job).

4. Selections: Material and Slice
When producing end-use parts with FDM, spend a few 
minutes to consider the options for materials and slice 
heights. These are the first selections made when processing 
parts in the software; they are fundamental to the product’s 
performance, as well as the efficiency of the operation.

Start with the material decision (Figure 34). Then, move on to 
slice height selection.

4.1.	 Material selection (*) (Ae, St, Ti)

The following are the top three selection criteria listed in 
order of importance:

•	 Material properties (Figure 35)

•	 Consider the operational demands for the part in 
terms of mechanical, thermal, chemical and electrical 
properties.

Figure 31: Open first region in Insight 
sofware.

Figure 32: Combine files for both region 1 
(red) and region 2 (green).

Figure 30: CAD model of region 2 with 
reference feature.

Figure 33: Result of variable density.
Figure 34: Select materials first and then 
select slice height.  

Mechanical Properties English Metric

Tensile Strength 5,200 psi 36 MPa

Tensile Modulus 350,000 psi 2,413 MPa

Tensile Elongation 4% 4%

Flexural Strength 8,800 psi 61 MPa

Flexural Modulus 336,000 psi 2,317 MPa

IZOD Impact, notched 2.6 ft-lb/in 139 J/m

IZOD Impact, un-notched 5.3 ft-lb/in 283 J/m

Figure 35: Review FDM material data sheets to find the desired properties. (Build orientation is on 
long side.)
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•	 Support material

FDM offers two support styles: breakaway and soluble. The material 
selection will dictate which styles are available so consider if the 
advantages of soluble supports (e.g. automated, labor-free and fewer 
concerns over access) are required. If so, choose a material that offers the 
appropriate type of support (Table 1).

•	 Slice height (Figure 36)

Materials also determine which slice heights are available (Table 1). Slice 
height affects surface smoothness and specifies available raster and 
contour widths (see Section 4.2).

FDM Material Support Style
Slice Heights 
mm (in)

ABSplus Breakaway or  

Soluble

0.127 (0.005)** 

0.176 (0.007) 

0.254 (0.010)

ABSi Soluble 0.127 (0.005)** 

0.176 (0.007) 

0.254 (0.010) 

0.330 (0.013)

ABS-M30 Soluble 0.127 (0.005)** 

0.176 (0.007) 

0.254 (0.010) 

0.330 (0.013)

ABS-M30i Soluble 0.127 (0.005)** 

0.176 (0.007) 

0.254 (0.010) 

0.330 (0.013)

ABS-ESD7 Soluble 0.176 (0.007) 

0.254 (0.010)

PC-ABS Soluble 0.127 (0.005)** 

0.176 (0.007) 

0.254 (0.010) 

0.330 (0.013)

PC Breakaway or 

Soluble

0.127 (0.005)* / ** 

0.176 (0.007) 

0.254 (0.010) 

0.330 (0.013)

PC-ISO Breakaway 0.176 (0.007) 

0.254 (0.010) 

0.330 (0.013)

PPSF Breakaway 0.254 (0.010) 

0.330 (0.013)**

ULTEM™ 9085 

thermoplastic resin

Breakaway 0.254 (0.010) 

0.330 (0.013)***

Figure 36: Slice height selection establishes which tips to 
use.

Table 1: FDM material options.
* Soluble only
** Fortus® Production System 400mc only 
*** Fortus® Production System 900mc only
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4.2. Slice selection (*) (Ae, St, Ti)
Table 1 lists the available slice heights for each of the FDM materials. 
Slice height specifies the thickness of each layer. This will affect surface 
resolution and stairstepping. It also determines which extrusion tip to use, 
which in turn, dictates the range of raster and contour widths (Table 2).

Important: Slice selection influences build time, surface quality, feature 
resolution and part strength. Therefore, take into account each of these 
factors:

Thinner slices:

•	Thinner layers = smoother surfaces

•	More layers = increased build time

•	Narrow toolpaths (rasters and contours) =

-- Finer feature resolution
-- Denser fills for thin walls

Thicker slices:

•	Thicker layers = faster builds

•	Fewer layers = increased stairstepping

•	Wider toolpaths (rasters and contours):

-- Faster deposition and shorter builds
-- Stronger parts

Table 2: Slice height variables. 
* Material configured for individual toolpath settings.

5. File Processing (Insight)
Although Insight software’s “green flag” defaults will produce acceptable, and 
usually very good results, there are many control options to consider. These 
options apply to both the model and the support, and are used to improve 
part quality and process throughput. The following file processing actions are 
commonly used to improve end-use part designs while maximizing process speed.

5.1. Part orientation (*) (Ae, St, Ti)
Part orientation is one of the few required actions for every part. Whether using 
the default toolpath parameters or customizing toolpaths manually, it is the first 
step. Although orienting to minimize the Z-height, and possibly build time may 
be a viable strategy, the following are equally important considerations (Figures 
37 - 39).

Slice Height Tip
Minimum Toothpath 
mm (in) 

Maximum Toolpath 
mm (in)

0.127 (0.005) T10 0.20 (0.008) 0.58 (0.022)

0.176 (0.007) T12 0.30 (0.012) 0.73 (0.028)

*PC & PC-ISO T12 0.25 (0.010) 0.68 (0.026)

0.254 (0.010) T16 0.41 (0.016) 0.83 (0.032)

*PC-ABS & PC-ISO T16 0.41 (0.016) 0.88 (0.034)

*PPSF & ULTEM T16 0.41 (0.016) 0.78 (0.030)

0.330 (0.013) T20 0.46 (0.018) 0.98 (0.038)
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5.1.1.	 Considerations:

•	 Strength

-- Orient the part so that forces and loads are perpendicular 
to the slices.

•	 Surface finish

-- Orient the part so that the part’s critical contours are in the 
XY plane.

•	 Build time

-- Orient the part to:
•	 Minimize build height.

•	 Reduce the volume of support material.

•	 Minimize the number of layers that contain both model 
material and support material.

•	 Time and ease of support removal

-- Orient the part to minimize the amount of supports and to 
make support removal easy.

-- Small cavities are oriented so that supports have access 
for removal.

•	 Airflow

-- Ensure uniform airflow on parts, especially for higher 
temperature materials (ULTEM thermoplastic resin and 
PPSF).

5.1.2.	Software settings

There are two recommended options in the software to orient a part 
(Figure 40).

•	 (STL > Orient by selected facet) 

or

•	 (STL > Rotate)

5.2.	 Build styles (*) (St, Ti)
Insight software offers three interior fill styles: Solid-normal, Sparse, 
and Sparse-double dense. Select the appropriate style for the following 
characteristics:

•	 Strength

•	 Weight

•	 Material consumption

•	 Build time

Part interior fill style may be selected from: 

Figure 37: Default orientation when opened  
in Insight software.

Figure 38: Orientation for strength and minimal supports. 

Figure 39: Alternative orientation.

Figure 40: Orientation dropdown menu offering Rotate and 
Orient by selected facet.
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•	 (Modeler > Setup) 

or

•	 (Toolpaths > Setup)

The following are descriptions and characteristics of the interior fill styles.

5.2.1.	Solid-normal (Figure 41)

•	 Dense fill with no gap between adjacent rasters.

-- Rasters run perpendicular to those on the preceding layer.
•	 Characteristics:

-- Strongest
-- Heaviest
-- Highest model material consumption
-- Longest build times

5.2.2. Sparse (Figure 42)

•	 Hollow interior with internal lattice for structural rigidity.

-- Large air gaps between rasters
-- Uni-directional rasters on each layer (Figure 43)
-- Raster angle alternates between layers

•	 Characteristics:

-- Weakest
-- Lightest
-- Lowest model material consumption
-- Shortest build time

5.2.3. Sparse – double dense  (Figure 44)

•	 Hollow interior with internal lattice for structural rigidity.

-- Same as Sparse, except bi-directional rasters on each 
layer (Figure 45).

•	 Characteristics compared to Sparse fill:

-- Stronger
-- Slightly heavier
-- Slightly more model material
-- Slightly longer build time

5.2.4. Optimizing sparse fills

For both Sparse and Sparse-double dense, several toolpath 
parameters can be changed to optimize weight, strength and build 
time. Adjustments are made through either 

•	 (Toolpaths > Setup > Toolpath Parameters) 

or

•	 (Toolpaths > Custom Groups > New/Modify)

The most frequently changed settings are (Figure 46):

•	 Number of internal contours:

-- Default is the thickness of one contour. Increase The 
number of interval contours to add strength to the surface 

Figure 41: Part with Solid –normal fill.

Figure 42: Part with Sparse fill.

Figure 43: Sparse fill alternates raster direction for each layer.

Figure 44: Part with Sparse – double dense fill.
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of the part.
-- Note: The total perimeter thickness will be the “number 

of internal contours” value plus two default contours. In 
addition to the internal contours, there will be two contours 
on the outside of the part. 

•	 Part sparse solid layers: number of slices above and below the 
sparse fill that will have a “Solid-normal” fill style. 

-- Increase part sparse solid layers to add strength to the top 
and bottom surfaces.

•	 Part sparse fill air gap: the distance between rasters.

-- Default, which ranges from 1.52 mm to 2.54 mm (0.060 in 
to 0.100 in), is dependent on material and tip size.

-- Increase to reduce build time and material consumption.
•	 Large values are possible but adjustments may be 

needed for other parameters.

5.3.	 Visible surface style (*) (Ae, Ti)
Set visible surface style to “Enhanced” (Modeler > Setup).

Enhanced mode uses small rasters for the toolpaths of external, visible 
surfaces. The visible surfaces also have a small negative air gap to press the 
rasters together (Figure 47). Internally, it uses thicker rasters with no air gap 
(Figure 48). The default values are listed in Table 3. 

This style improves surface finish while decreasing build time. 

Enhanced mode allows separate adjustment of raster widths and air gaps for 
the internal and external toolpaths (Toolpaths > Setup > Advanced settings) 
(Figure 49). They include: 

•	 Visible surface raster (width): Reducing the surface raster’s toolpath width 
eliminates porosity and improves the overall appearance of the part.

Figure 46: Advanced parameters for sparse fills include 
number of interior contours, solid layers and size of air gaps.

Figure 45: Sparse – double dense fill uses crossing rasters 
on each layer.

Figure 47: Enhanced mode produces narrow rasters with a 
small negative air gap for smooth surfaces.

Material Tip Size Visible Raster mm (in) Visible Raster Air Gap mm (in) Internal Raster mm (in) Internal Raster Air Gap mm (in)

ABS-M30, 
ABS-M30i, 
ABSi,  
PC-ABS

T-10 0.23 (0.009) -0.03 (-0.001) 0.41 (0.016) 0.000

T-12 0.30 (0.012) -0.03 (-0.001) 0.51 (0.020) 0.000

T-16 0.43 (0.017) -0.03 (-0.001) 0.61 (0.024) 0.000

T-20 0.56 (0.022) -0.03 (-0.001) 0.81 (0.032) 0.000

ABS-ESD7 T-12 0.30 (0.012) -0.03 (-0.001) 0.51 (0.020) 0.000

T-16 0.43 (0.017) -0.03 (-0.001) 0.61 (0.024) 0.000

PC-ISO 
PC

T-12 0.30 (0.012) 0.000 0.51 (0.020) 0.000

T-16 0.43 (0.017) 0.000 0.61 (0.024) 0.000

T-20 0.56 (0.022) 0.000 0.81 (0.032) 0.000

PPSF T-16 0.43 (0.017) -0.03 (-0.001) 0.61 (0.024) 0.000

T-20 0.56 (0.022) -0.03 (-0.001) 0.81 (0.032) 0.000

ULTEM 9085 T-16 0.43 (0.017) -0.03 (-0.001) 0.61 (0.024) 0.000

T-20 0.56 (0.022) -0.03 (-0.001) 0.81 (0.032) 0.000

Table 3: Enhanced mode default settings.
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•	 Visible surface rasters air gap: Using a negative air gap on surface rasters 
can eliminate slight air gaps between rasters, thereby increasing density 
and improving surface finish.

•	 Internal raster (width): Increasing the internal raster’s toolpath width will 
reduce build time and increase vertical layer strength.

•	 Internal raster air gap: Increasing the internal raster’s air gap will decrease 
build time.

5.4. Custom group: fill density/porosity (*) (St)
Using the defaults for contour style and contour width across all features on 
an FDM part may result in porosity and air gaps. These voids will decrease the 
strength of features, such as thin walls and bosses. For example:

•	 Thin wall: A single contour pass may leave an air gap if the distance 
between the contour’s sides is not large enough for a raster fill (Figure 50).

•	 Boss: At the contact points of the rasters with the contour, the raster 
turnaround will leave a small air gap. If tapping the boss, for example, the 
porosity would be exposed (Figure 51).

Eliminating the voids increases strength. To do this, use custom groups to 
apply user-defined values to the style and width of the outer shell 
(the contours) of individual features. The first approach uses the Multiple 
Contours style.

Procedure:

5.4.1.	Create custom group (Toolpaths > Custom groups > New).

Give the custom group a group name and click the checkmark to 
save it.

5.4.2.	Calculate contour width.

To eliminate voids in a wall or boss, enter a contour width that is an 
even multiple of the feature’s thickness because all curves must be 
closed. For example, a 2.0 mm (0.080 in) wall could potentially have 
a contour of 1.0 mm (0.040 in), 0.5 mm (0.020 in), 0.3 mm (0.013 
in) or 0.25 mm (0.010 in). So, begin by measuring the feature and 
dividing its value by even numbers (Figure 54).

Next, confirm that the desired width is available for the job’s tip size. 
For a T16 tip, the 0.5 mm (0.020 in) value is the default option. The 
available widths are visible in the dropdown menus of the toolpaths 
and custom group settings functions.

The selected width value becomes the contour width setting in the 
next step.

5.4.3.	Define toolpath settings (Figure 52).

With the custom group displayed in the Group Name dialogue box, 
select “Modify” from the custom groups pane. Change contour style 
to “Multiple contours,” which provides a user-definable perimeter 

Figure 48: Internally, rasters are wider which reduces build 
time.

Figure 49: Sample parameters for Enhanced mode.

Figure 50: Defaults may produce voids in thin walls when 
rasters cannot fill between contours.
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thickness made from one or more contours.

Next, set the value for contour width which was 0.5 mm (0.020 in) in 
the above example. Then, set the number of contours to two. 

The result is a feature with both an inside- and outside-surface 
thickness of 1.0 mm (0.040 in) 

5.4.4. Add curves to custom group.

Select all curves that will use the new custom group and click “Add.”

5.4.5.	Generate toolpaths (Figure 53).

The last step is to generate toolpaths, shade and view them 
(Toolpaths > Shade toolpaths or right click > Shade toolpaths). The 
result should be solid fills with no gaps between rasters. If gaps exist, 
adjust the custom group values accordingly.

This type of custom group can also create features with an internal 
raster bounded by the user-defined multiple contours. The next 
approach to improve strength is very similar, but it uses the “Single 
contour only” style which can have only one contour.

Procedure:

5.4.6. Create custom group.

Follow the instructions for 5.4.1. and 5.4.2. For the latter step, divide 
the measurement by 2 only.

5.4.7. Define toolpath settings (Figure 55).

From the custom groups window, select “Modify.” Change “Contour 
style” to “Single contour only,” which provides a user-definable 
perimeter thickness made from one contour. Next, set the contour 
width value to the number calculated in 5.4.6.

Note: This method will not work with a 2.0 mm (0.080 in) feature 
using a T16 tip. The necessary value (1.0 mm /0.040 in) is not an 
option for this tip size.

5.4.8.	Add curves to custom group.

Select all curves that will use the new custom group and click “Add.”

5.4.9.	Generate toolpaths (Figure 56).

The last step is to generate toolpaths, shade and view them 
(Toolpaths > Shade toolpaths) or (Right click > Shade toolpaths). The 
result should be solid fills with no gaps between rasters. If gaps exist, 
adjust the custom group values.

5.5. Custom group: gradual slopes (**) (Ae)

Figure 51: Defaults may produce porosity at the point of 
turnaround.

Figure 52: Custom group settings for solid fills using 
“Multiple contours.”

Figure 53: Result – solid fill for boss.

Steps:
•	 Display measurements  

(View > Measure data).

•	 Right click and select 
either “Snap-measure” or 
“Measure.”

•	 Left click and drag over 
feature.

Figure 54: Measuring procedure within Insight software.
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On surfaces with a gradual slope, default toolpaths may produce 
visible pin holes at the point of raster turnarounds. This happens 
when the offset of a layer is larger than the contours of the layer 
below (Figure 57). To conceal the raster turnarounds and have a solid 
external surface, create and apply a custom group to the affected 
slices (Figure 58).

Procedure:

5.5.1. Create custom group (Toolpaths > Custom groups > New).

Give the custom group a group name and click the checkmark to 
save it.

Note: Do not give the group a name that already exists; all other 
curves with that name will be overwritten.

5.5.2.	Modify toolpath settings.

To conceal the raster turnarounds, increase the contour depth so that 
it overlaps with the contour layer above it.

Select “Modify” from the custom group window. Change contour 
style to “Contours to depth.” Next, increase the depth of contours 
value; make it large enough to cover the rasters below the contours 
for the next layer.

5.5.3.	Add curves to custom group (Figure 59).

Select all curves on the gradual slope surfaces and click “Add.”

5.5.4. Generate toolpaths.

After generating toolpaths, shade and view all affected layers 
(Toolpaths > Shade Toolpaths). Use the “View layer plus layer above/
below” setting to see if all raster turnarounds are concealed by the 
layer contours (Figures 60 and 61). If adjustments are necessary, 
return to the “Modify” function and adjust the “Number of contours” 
value.

5.6. Custom group: supports made with model material (**) (Ti)

Although it takes only a few seconds per layer, the time to switch between 
model and support material can have a noticeable impact on throughput. 
The increase in build time becomes more significant as the number of 
layers increases.

To eliminate this time from the build, create a custom group that builds 
supports from model material. 

Apply this technique when the design includes a large number of 
layers with both model and support curves (“Sparse style”), and 
when the supports are accessible and easily removed. This technique 
is only applicable for layers that contain just part curves (red) and 
“SupportSparse” curves (dark gray). To determine if these conditions exist:

Figure 55: Custom group settings for solid fills using 
Perimeter only.

Figure 56: Result – solid fill for thin walls.

Figure 57: On shallow slopes, raster turnarounds may be 
visible (left). Custom groups can correct this (right).

Figure 58: Area of interest (gradual slope) shown in this 
section view.

Figure 59: Select the curves in the area of gradual slopes 
(blue) and apply custom group.
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•	Generate supports

-- After slicing the file, set support style to 
“SMART” or “Sparse” (Support > Setup). Then 
click the “Create supports” icon.

•	View slices (Figure 63).

-- Scroll through all the slices. Look for:
-- Layers with only model (red) and 

“sparse/SMART” supports (dark gray).
-- Support curves that can easily be 

removed.
Avoid applying this technique to supports that are 
surrounded by model curves. With either condition, the 
supports will be difficult to remove without damaging 
the part.

To swap model material for support material, use the 
following procedure: 

5.6.1. Create custom group (Toolpaths > Custom 
groups > New).

Click the “Templates” icon and select 
“SupportSparse” from the Template group menu 
(Figure 64). Click the checkmark.

By using the template, the new custom 
group inherits all of the toolpath settings from 
“SupportSparse.”

5.6.2.	Modify toolpath settings.

The only setting that will change is “Toolpath 
material”. To make supports from model material, 
simply select “Model” from the dropdown menu 
(Figure 65).

Give the custom group a group name and click 
the checkmark to save it.

5.6.3.	Add default support curves to custom group.

Select only the support curves (gray) that are 
accessible and removable. DO NOT add basic 
supports (gold) or support interface (green) 
curves.

After selecting the curves, click “Add” from the 
custom groups window (Figures 66 and 67).

5.7.	Custom group: wide supports (**) (Ti)

The default settings for supports create a strong, rigid 
structure made from soluble or breakaway support 
material. To reduce the volume of supports, and 
therefore the time to construct them, increase the air 

Figure 60: View toolpaths using the two-
layer view to see if raster turnarounds are 
concealed. In this illustration, they are not.

Figure 61: With the correct “Multiple 
contours” setting, the turnarounds are 
concealed.

Figure 62: Visible turnarounds (left) from 
default settings. Concealed turnarounds 
(right) with 
custom group. Figure 63: View slices to find those with only 

support (gray) and 
model (red).

Figure 64: Create custom group using a 
template for SupportSparse.

Figure 65: Change Toolpath material to 
“Model.” 

Figure 66: Select the curves for the supports 
that will be made from model (white) material.

Figure 67: Apply the custom group (green) to 
build supports from model material.

Figure 68: Support tower with wide air gaps 
to decrease build time.

Figure 69: Top-down view shows wide 
spacing between support rasters.
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gap between each support raster (Figures 68 and 69).

The wide support procedure is defined in a custom 
group so that it increases the air gap and replaces 
support material with model material 
(Figures 70 and 71).

Apply this technique when there are large, tall groupings 
of SupportSparse towers — or more generally, a lot of 
SupportSparse surface area — that are accessible and 
do not surround any model features (Figure 72). 

Procedure:

5.7.1. Create Custom Group 1 (Toolpaths > Custom 
groups > New).

Click the “Templates” icon and select 
“SupportSparse” from the template group menu 
and click the checkmark.

By using the template, the new custom 
group inherits all of the toolpath settings from 
SupportSparse.

5.7.2. Modify toolpath settings (Figure 73).

Change toolpath material to “Model” so that 
the supports will have the strength to support 
the part. Next, set the start angle to -30° (90° 
counterclockwise from the default angle).

The last setting adjusts the adjacent rasters 
air gap by increasing the spacing between the 
support rasters. This value can be up to 19.1 mm 
(0.75 in) with no other alterations.  

Give the custom group a group name and click 
the checkmark to save it.

5.7.3. Create Custom Group 2 (Toolpaths > Custom 
groups > New).

Click the “Templates” icon and select 
“SupportSparse” from the template group menu 
and click the checkmark.

5.7.4. Modify toolpath settings (Figure 74).

Use the same settings as in Step 5.7.2. for 
toolpath material “Model” and adjacent rasters air 
gap.

Set the delta angle to 90° and the layers between 
deltas to 99. These settings place a layer of 

Figure 70: Default Sparse support toolpaths 
(right).

Figure 71: Wide air gap supports (right).

Figure 72: Select support towers that are 
accessible and do not surround part features.

Figure 73: Settings for Custom Group 1.

Figure 74: Custom Group 2 adjustments.
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Figure 75: Toolpath regions after applying Custom Groups 
1 and 2.

support that runs perpendicular to the 99 layers below it. This acts as 
a cross-member that keeps the support column rigid and stable.

Give the custom group a group name and click the checkmark to 
save it.

5.7.5.	Add curves to custom groups.

After selecting and applying the custom groups, the support columns 
should build with the following order of toolpaths (Figure 75):

•	 Bottom 10 layers: Custom Group 1  
(-30° raster angle)

-- The wide supports cut across the default supports 
(if parallel to them, they would “fall through the cracks”). 
(Figure 76).

•	 Middle layers: Custom Group 2

-- First 99 layers (counted from the first part layer): -30° raster 
angle

-- Next layer: 60° raster angle 
 
This set of alternating raster angles repeats every one 
hundred layers and stops when only 10 layers remain.

•	 Next 10 layers: Custom Group 1  
(-30° raster angle)

-- To form a bridge for the final layers
•	 Top 10 layers: Default supports

-- Default supports are required because this is where the 
change to support interface occurs.

To establish this pattern, locate the layers that contain the support 
curves that will use wide air gaps. Next, set the Range Top to 10 
layers below the top of the supports and Range Bottom to the 
bottommost layer of supports. Now, display this range by clicking on 
“View range of layers.”

Select the bottom 10 and top 10 layers for the range and add them 
to Custom Group 1. Then, select all remaining layers in the range and 
add them to Custom Group 2. For parts with many features, selection 
may be easier if some model curves are hidden (View > Hide curves). 
To further simplify selection, use the selection tools (Figure 77) that 
appear in the custom group pane (e.g. by group name, color 
or curve type).

6. Throughput & Production Planning
When compared to conventional manufacturing processes, FDM is unique in 
several ways:

•	 It can operate as a self-service process.

•	 It can build a variety of parts in a single operation.

Figure 76: Wide supports in Custom Group 1 run 
perpendicular to default supports.

Figure 77: Use the selection tool when selecting curves.

Figure 78: Build small lots of parts, even one-off, without 
concern for setup and changeover.
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•	 It is an unattended operation.

This uniqueness offers advantages but only when leveraged. To do so, a change 
in thinking and operational style may be needed. When scheduling an FDM 
system job, consider the following:

•	 No setup (changeover) time required (Figure 78).

−− Small batch runs and one-off builds are economical and efficient. Parts 
can be built one at a time and as needed.

•	 Production mix is unlimited (Figure 79).

−− Build any combination of parts, prototypes and manufacturing tools.

−− Combine work for multiple staff members, departments or divisions.

•	 Multi-piece runs increase throughput.

−− By sharing the operational overhead, such as the time to purge a tip, 
the time per part decreases.

−− The tallest part will carry most of the process overhead.

•	Builds can be matched to shift schedules (Figure 80).

−− To maximize throughput and minimize downtime, consider the shift 
schedule when laying out builds, launching runs and planning the 
production schedule. 

−− Match jobs with the start and stop times of shifts. Avoid scheduling 
jobs that will consume the better part of a weekend and jobs that will 
run over a long holiday. It is inefficient to end a build when there is no 
staff available for changeover.

The production planning and scheduling tools are:

•	 Control Center

•	 Insight software

6.1. Packing the build sheet (*) (Ti)

This operation is basic and routine, but important.

In Control Center, add individual jobs saved from the software to maximize 
throughput. Additionally, plan the production of parts in coordination with 
the work schedules of those who will remove them and start the next job 
to maximize efficiency.

Procedure:

6.1.1. Create a pack.

While in the Control Center Pack tab, click “Insert CMB” and browse 
for the desired file. Click “Open” (Figure 81). Repeat until all desired 
parts are in the pack.

Figure 79: Combine multiple parts, in any combination, for 
building.

Figure 80: Maximize throughput with multi-part builds.

Figure 81: In Control Center, insert CMBs to create a pack.
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6.1.2.	Optimize the pack.

To add duplicates of any part in the pack, click “Copy.” 

Next, arrange all parts by clicking and dragging, rotating or 
repacking.

NOTE: The incremental time reduction will decline as parts are added 
(Figure 84). 

6.1.3. Monitor the estimated time in the Pack Details window.

Adjust the time to match the production schedule (Figure 83) by 
adding, copying or removing parts from the pack (Figure 82).

6.2. Nesting parts (***) (Ti)
Control Center prevents parts from impeding on the bounding volumes of other 
parts. It also optimizes the travel of the extrusion head for individual parts rather 
than planning the path for the collection of 
all parts.

To optimize build packing and extrusion head travel, nest part files in the 
software prior to sending them to the Control Center (Figure 85). Using this 
technique, parts can be stacked, overlapped and nested. One example is the 
placement of a part in a center void of another, like a torus (donut shape). 

Procedure:

6.2.1.	Open and slice Part 1 (Figure 86).

Save the job file (File > Save as > Job).

6.2.2.	Open and slice Part 2 (Figure 87).

6.2.3.	Add Part 1 to Part 2’s job file (Figure 88).

•	 (Slice > Combines slice curve files)

•	 Click “Slice file” field and select Part 1.sjb 
file

•	 Place Part 1.

-- Click and drag to a new location or 
enter coordinates in slice curve location fields.

•	 Click “OK” to add the part.

Note: If placement needs adjustment after the part has been added, 
use the “Edit > Move, rotate, copy” function.

6.2.4.	Create toolpaths and supports.

6.2.5. Save toolpaths (File > Save as > Toolpath).

This creates a .cmb.gz file that is commonly called the “CMB.”  To 
build this set of nested tools at a later date, select “Insert CMB” while 
in the Control Center. Then, process the build as usual.

Figure 83: Sample production schedule that accounts for shift schedules and weekends.

Figure 82: Duplicate or add parts and then place them in 
the pack.
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7. KEY PROCESS CONSIDERATIONS

7.1 Obstacle details: 

The following table presents common obstacles to end-use part 
production and recommended solutions. 

7.2 Resolution details:

•	Machine operations

-- Increase throughput and efficiency by managing job schedules to 
leverage “lights-out,” automated operations.

•	Group parts into a single build.

•	Design for FDM

-- Redesign parts to optimize the FDM process: self-supporting 
angles, offset surfaces, material removal and wall thicknesses.

•	Process control

-- Use advanced Insight software tools for fill styles, custom groups 
(e.g. strength, porosity and build time).
-- Select appropriate slice heights for feature size, surface finish 
and build time.

•	Secondary processes

-- For surface smoothness: mass finishing, vapor smoothing, 
secondary machining or sanding.
-- For accuracy and flatness: secondary machining.
-- For porosity: sealing or vapor smoothing.

•	Part orientation

-- Position part to improve feature accuracy, surface finish, 
strength, and build time.

•	Material selection
Figure 85: CAD model of a nested part.

Figure 84: Note that the incremental time reduction will 
decline as parts are added.

OBSTACLE RESOLUTION
Machine 
Operations

Design 
for FDM

Process 
Control

Secondary 
Processes

Part 
Orientation

Material 
Selection

Build Time Throughput not competitive with other manufacturing 

processes.
4 4 4 4

Porosity Internal porosity impacts performance. 4 4 4

Operating 
Conditions

Demanding requirements when in service (e.g., mechanical 

loads, thermal exposure, and chemical exposure).
4 4 4

Accuracy Dimensional accuracy does not meet operation specifications. 4 4 4

Surface 
Finish

Visible layers and toolpaths impact performance or 

appearance
4 4 4

Material  
Cost

Higher cost than other manufacturing materials. 4 4 4

Small 
Features

Resolution is too coarse to replicate. 4 4 4

Part 
Properties

Available materials do not offer properties that meet 

operational specifications.
4 4

Table 4: Common obstacles and resolutions
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-- Select the best material to meet the 
performance requirements (e.g. mechanical, 
thermal) instead of defaulting to what is in the 
machine.

8. Recap - Critical Success Factors

8.1.	Leverage the advantages of additive manufacturing by 
using good FDM practices.

•	Complex structures, including part consolidation

•	Design freedoms

•	Redesign and revision frequency

•	Automated, lights-out operation

•	Small-lot, on-demand production

•	Lead time and cost reduction

8.2. Optimize parts for FDM.

•	Strength

•	Aesthetics

•	Maximum throughput/minimal time

•	Lowest piece-part cost

8.3.	Invest time accordingly.

•	Pilot production – light adjustments

•	Bridge-to-production – moderate adjustments; 
some optimization

•	Full production – complete redesign; full 
optimization

•	End-of-life production – moderate adjustments; 
full optimization 

8.4.	Eliminate adoption obstacles.

•	Adopt FDM best practices.

Figure 87: Open and slice the second part. 
(Example duplicates a single part.) 

Figure 88: Combine the job files.

Figure 86: Open and slice the first part.

Figure 89: A redesigned end-use part from 
Nova Tech Engineering (PC-ABS). 

Figure 90: Production assembly utilizing FDM 
end-use parts (ABS-M30). 
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